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IR« A L—VHDETRIHLTAY Y FER
X9, TAV YIS AT T BB, [Y1U7
TRl (SignOub) 27V v LEJ,

F14 X9 5M< (Open from Disk) (EvyarvE
BATvaYy) o—hl - VAT LR EEN TV S Y
vavicBEILTZEDOY Yy Y3 R, o4
varvz7YUv 7 LEY, Command+O F— (Mac D
B&) F7zld Control+O F— (Windows D E) 7z
LTh. FUCEENEITENET,

F+ 2t (Cancel) 70 = 7 F OIERRIEH #2117
FTEHLRY Y aR—=R T4V RUEKTT BT,
DX TavEI ) I LET,

fERE (Create) /B< (Open) [1ERL] (Create) %= 7
Vw2l dbeXyyaR—RKBMRTL, AL n
Vil bRERZBHLTH LWL T BY 27 FABMERE N
%9 ([¥ERE] (Create) 27 DH), [B<]1 (Open) %z~
Vwrdse BRLETOY 7 MAHEET ([BRiF]
(Recent) #7'& [ZOYxH M (Project) X7 D),
Return F¥— (Mac D) £72id Exit F— (Windows
OLE) ZHLTE, TaYz 7 FOERRESHZETS
ZEMTEET,

EEBIFICRT (Show on Startup) COF 7> 5 V%
M % & Pro Tools DIEZENRFIC Xy & 2 R — Rk
RENIEL 7R 9, Pro Tools DIEEHIKHC E 5 — 4y
T aR— RZ2RREEBICE. BRE] (Settings) > [#E
#E] (Preferences) > [&ir] (Display) &R L T
[Pro Tools DEERFICH v ah— RD 4V RO ZERR]
(Show Dashboard window when Pro Tools starts)
FTa v LET,



[{ERE] &0 DR

[{ERE] (Create) ¥ THREFESTNEVESR. UTOLFhh
ZTVWET .

n Xy ¥aR—NRT [fER] (Create) 27 %27V v
LE9,

s X2 R—FT, Command+1 F— Mac DIGFH)
£721d Control+1 F¥— (Windows D¥&) ZH#H L
9,

» XY aR—FT, Command F—Z#LAENS ET
DEANF—ZL TR T EZYIDEZET,

= Pro Tools C. [T 7-1)L] (File) > [##R{ERK] (Create
New) %ZiEiRd %A . Command+NF— (Mac D
BE) 7213 Control+N F+— (Windows D HE) %z
FLETD,

»  Pro Tools T. [Z 7] (File) > [#i#R{ERL] (Create
New) ZiERT %H. Command+N F— (Mac D
58 £7213 Control+N F— (Windows D &) %
LT,

147 (Type) AT avzfHLT, 7OYTY
NOSUR) eeyvyay (m—h))) OEELDEA
TVES B D ELE T, Command F—7%Z#L
BMNSEADKAF =219 (Mac D¥%E). Control
F—EMLAENLEAEDKAIF—2MF L (Windows
DEE). XA T YD BEZ BT EMTEXT,

£ZEi (Name) 70y =7 FOLHiZANLET,

FIL— b5k (Create from Template) 7 >/
TL—rEHERLTTOY 7 M EERT 2581, 20
ATy avEAEMcLET,

FITL—=kII—T (Template Group) f#iZ L 7z
WFYTU—b - JIb—TZ#ERL %9, OptionF—7%
HLAEDS EFORAIF—Z21dH (Mac DHE). Alt
F—HMLAENS EFORAF—%H#HT & (Windows
DEE), HHRERT Y T L—bk - F)—TEZX 70—
VT BEMTEET,

T7ALI+ F47 (File Type) 70>z rDT7A)b -
147 (WAV £7213 AIFF) %Z3%E LE 9, Command+F
F— (Mac D¥5) % 7zl& Control+F +— (Windows
DEE) 2T L, 20077 A)V - AL TRYDEZ
LT ENTEET,

8  Pro Tools D#kkE

B« L—b (Sample Rate) 7oz 7 FDYy
VN L— b EEELET, Command+R F— (Mac
DE) £72id Control+R F— (Windows D) 7%
oL, WEZAZO—)VEETENTEET,

Ev b «FJIR (Bit Depth) 7oy 7 FOEwW b -
FTA (16EY F, 24E¥ v b p. FiF32E Y FOFE
B/ Z2iE LE 9. Command+B F— (Mac D
LA F721E Control+B F— (Windows D¥E) ZHf
F&., AR AL TS a v ERYDBZBENTE
9,

1/08&E (I/O Settings) Yu>y =7 FTEHT 3 1/0
REZEELE T, Command+] F— (Mac DHH) F
fzi& Control+l F¥— (Windows D¥) ZH#id &, fiiH
AJREIRI/OREDNA T a v EYIDEZ 5 LN TEET,

149 —U—7J (Interleaved) DX 7> 3V &HH)
IKT2L. A VE=—V—=T AT LADFr—FT 4% T 7
ATy FAIERENE T, Command+G
F— (Mac D¥E) %7213 Control+G F— (Windows
DEE) 2 e, [14v¥—U—TJ] (nterleaved) £
avORMENZYIDEA BT LA TEXT,

REFIEMZEIR (Prompt for Location) (Ev <3
VBRATYVAV) DX T arvEANCT B L,
vy a Y ORGESMEIEET SlcbDTur T Mk
RENF T, RFHFAZERER] (Prompt for Location)
F TV a v EREMICT S . 18] (Location) & 7' 3
Y EHEIICBENC A D X9,

1Bf (Location) (Bv¥ayER4JIvaY) vy s
YOTT AN ORFEGEFZEET S ICiE. BBA]
(Location) "= >z 21 v 7 LE 9, B (Location)
AT avREMCT B L. URFGMZRIR] (Prompt
for Location) & 7> 3 HBIICHENICIR D £9,
[®E] 97

[&f] (Recent) #77%ZRd 5k, ¥y¥ah—NR
T[&if] (Recent) X 77% 7V v 79 %h ., Command+2
F— (Mac DHH) £721% Control+2 F— (Windows
DEE) ZMUET, [BE] (Recent) X 71iCid, &i%
WKLy yayvelayo 7 bR 10EEREN
FIH, ThSCR, CoRTEFOaAR YR, £
vayv, RERFRENEEA, VANAOTTOY 2
M XTI Vv rERE, TOTOT s MHME
£9, oAV TVWEVWES, REffALEToY
7 MIFREINEE A,



[o0JxI08 97

[ZOY xR (Project) # 7 2#&Rd 5icld, Xy a
A—RT [FJOVxI K (Project) 27 %7V v 73 %h,
Command+3 F— (Mac D¥;&3) £ 7zid Control+3 F+—
(Windows D& ZH L %97, [FOY o K] (Projects)
ZT7E. BOMER LT 59 RicELIc7ayx
b, EREBEEATSRL—YarEiToTWSE 70
Vol PWIRTERENET, YVAMAOTBY 27 b
BETNVZIwrT3E, OOy bHHEET,
a4 LTWaEWEE, 7ay sy NIERENETA,

FvYaRk—RODZDOMDF—K—KYa—p
Ay k

TH—HAENTNWETYTL—hk - UZAb, Y3
YeUARb TOVY - UXNNERBEITSICE,
FTFORHIF—ZMT N Mac D). AltF—ZHL
TS ETRORAIF—ZMLET (Windows DIFE),

TRENTVB Y X FOREHOEHZHEIRT 510
Home F—7Z# L. REDEHZEIRT 511X End F—
ZMLE T, TOEMEIE. Mac & Windows THIE T,

TH—HAENTVWB 7T L—h - UXb, Ev¥a
YeURL, TaYx sk YA MR ERMICA T
VT Blcid Page UpF—Z ML, FAMIICAZ B—)LF
%13 Page Down +—Zfi L £J. T DHMEIF. Mac
& Windows THl T,

EBROY Y Y a1R— FORTEIRTZY
b&X3

EHRICY v Y ai— RERTEFRBIRTICTSICIE. ROV
FNDOETVET,

s Xw¥aR— FT, [EEFICERR] (Show on startup)
X Ty aveath (FrEEsh) icLxd,

» [ER%E] (Setup) > [¥HAERE] (Preferences) &
LT, HHREERR XR=YDBLELHA4T7 0
7«73 >7C, [Pro Tools &S Y ¥ 1 R—
RO« RO%ZERTR] (Show Dashboard window
when Pro Tools starts) 4 7Y 3 V2 EIRE 7z1d:%
REEFR L X9, EIRT B L RRIN, BIREMERT 2
CIERRICIEDET, [OK] Z7V w7 LET,

#%3E: Pro Tools®70O0Y 1o b

FYIb—-bheERLTHLLEY Y3 Y
ZIERT D

FYI—bMEERLTHLVLIOI T MEERTBICIE -

1 Xy ¥aR—RT [{EM] (Create) X7 %7 Vv
T20 (FRENTVEWVEE), Command+] F—
(Mac D) F 721 Control+1 F— (Windows D
BE) ZIUED,

2 [47] (Type) 7> a>r T, [FOVIIs (U5
2 R) 1 (Project (cloud)) £7zi& [Evyar (O—
#IL)] (Session (local)) ZZRL £,

3 [&# (Name) 7+ —J)VRT, 7avz ¥ b%xE A
hrEd,

4 [FVTUL—bh 5] (Create From Template) %
Ta vEEMCLET,

5 [FYFL—KIIL—T1 (Template Group) R 777
T AZa—T, #HTBT I L—DATIVE
BRLUF S ([F9—] (Guitar) » [VYISA5—]
(Songwriter) &),

6 LoV ART, HHATETY S L—FEERLED,

Dashboard

2 Theodore Gadamer v
CREATE Type: [Project *| (013 Projects)

Name: | Full Session
RECENT

Create From Template

PROJECTS
‘Template Group: | Eleven Rack

@ Full Session
=

B Guitar Tracking
—

B Guitar Tracking + Re-Amping
=)

File Type: | BWF (WAV) Sample Rate: |48 kiz

Bit Depth: | 24-bit. 10 Settings: | Last Used =

Interleaved

[ 7 U—bbS1ER] (Create From Template) 47 3
UHERICE D TVDIREDS v v ai— R



7 VTN TEY LI R RT AR —REET DY
HiE. LFOVWTNHZITOET,

o [A—F 1A T74)LF4T1(Audio File Type) (WAV
FRIFAIF) ZEIRLE T,

« [Ew rFTR] (Bit Depth) (16 Ev k. 24 Ew
F7213 326w FOFEVIEEED) EERIRLET,

e [BVTILL—HK] (Sample Rate) ZEFERL X7,

s AVE—Y=T NFF v RN A =T 4 F Ty
AWZEVEKRT Bk, [« > —U—TJ] (Interleaved)
EHMCLUET,

o v ayOBEDOH: REFSEFZZER] (Prompt for
location) A 7> a3 v F#id U] (Location) 47
aVEERLES, BT (Location) 47> 3 v
Z#IRT % L. B (Location) KX > ZTVUw o
LT, v ya ®Z R ET5 77 40 s OEFiEIRE
TXET,

8 [fEm] (Create) Z7U v 7 L%9,

9 Ly arYoOREORH  MERXATOT T, kv g
VEMRET B EIRL T RE] (Save) %7
Vw7 LET,

Q Mac & Windows & DEIMEEEDI®IC, T 7
A+ 2L T%BWF (WAV) IZ#&ELTL 72
AN

mLLnZDTOY I M EERT S

FuLnZEOTOY I MEERTBICIE :

1 Xv¥aRh—FT [ER] (Create) X7 %7 VUwv o
T3 ERENTOEVES). Command+1 F—
Mac D¥#3) F7ziZ Control+1 F— (Windows O
BE) ZMLET,

2 [F47] (Type) A 7> a v T, [FOVIUL (U5
D R)1 (Project (cloud)) ¥7id [Evrar (O—
#AIL)1 (Session (local)) ZEERLET,

3 [®&A1] (Name) 74 —J)VRT., Javzr %A
HLET,

10  Pro Tools D#rHEsE

4 [FVTL—bH51ER] (Create From Template)
ATV a VHINERIREN TV C e 2R L E T,

Dashboard

% Respectable Citizen (Storage: 20%) v

CREATE Type: | Project ~| (7110 Projects)
Name: | Untitled
RECENT

Create From Template.
PROJECTS
Template Group: | Eleven Rack

-

File Type: | BWF (WAV) S Sample Rate: |44.1 kHz

Bit Depth: |24-bit 10 Settings: | Last Used

Interleaved

Show on startup.

Fyak—RTHLWLWEY V3 VZER

5 WINHhDTOY LY b RTA—R—EEHT B
i, LFonFnhzitnEd,

o [A—F 174 T 7454 T1(Audio File Type) WAV
FFAIF) ZERLET,

« [Ev rTTFR] Bit Depth) (16Ew bk, 24Ew b,
3328y MNEEVIERED ZERLET,

e [HUTILL—HK] (Sample Rate) ZERL K9,

« vzl hTHHTS [IJOFE] (/O Settings)
ZEIRLE T, BIFO /O REDH A SEIRT 2h.
HiizlcER U7z [I/OERRE] (I/O Settings) ZERL
£9,

o AVBR=V=T RIVFFY I I =T 1% Ty
A NWEVERT 512, [4 5 —U—T] (Interleaved)
EEMCLET,

o v Ta vOBREDOH: REFSFEER] (Prompt for
location) 7> 3 v F i [EFR] (Location) &7
T VEERLES, B (Location) 7> 3 v
ZiEIRT % &, BT (Location) R&>%Z7 Vw7l
LT, v ya vz RET 277 40 DGz TRE
TEZET,

6 [fERE] (Create) Z27 Vv 7 LEd,

7 Ly aroREEOH fMEEAATaT T, kv
VERBET BT EINL T UR%E] (Save) &7
w7 LET,




mEERALEIOY I MR

A\ Pro Tools B TREI LIty (£, [77
V] (File) > Dt v 3 %< ] (Open
Recent) > [Z7 V7] (Clear) ZERL T [k
Dt 3] (Recent Sessions) VA L%z
T USRS REDOty v a v ZB<] (Open
Recent) 47> a VIZBINTCEELA,

REEALEIOY Y MERLKICE :

1 Zvw¥aR—RT [BE] (Recent) Zi#IRT % M,
Command+2 +— (Mac D) % 7zld Control+2
F— (Windows D¥&) ZMLET,

Dashboard

X Respectable Citizen (Storage: 36%) v

CREATE

-

\| BLAST_proj
Tocay, 3:57 PM

RESENT 3] BLAST_sess

oday, 3:46 PM
PROJECTS BachSuites
ocay, 3:46 PM

UMLOUD
ocay, 3:45 PM

(7% WhirrledBeat
0 Today, 12:08 AM

BBBDVGMZMZ_040110x
festerday, 7:03 PM

bbbdmzvg-040210
e Yesterday, 1:37 PM

Show on startup

BEEALEEYYaY/ 7OV FDOUR MORRENTE

Fyvak—K

2 AU AT REHHLEZ 100Dy avERk
B avz 7 bOVWITNhEBRLET, Y121V
LTWiane, YA Mc7ade? FEERENEn
TEICHRLTLEE W,

3 [F<] (Open) 27Uy L%,

#%3E: Pro Tools®70O0Y 1o b

TSOLVEFT7IFT1+7ICLTIOY T
I hERIK

Pro Tools TW&. IRXTDTSS 5 A V%#IET 75 4 TR
BICLTTays 7 hEHSCENTEET, 2HOT
STAVERGHT S 7Y 7 R BEITER—S D
MBTERBOETN, TITAVEET VT4 TICT
pclicky, Tave s v ETIER LBV TR ZE
RBL., T597A 0 REHLUENA—T ¢+ A OHERETIE
RLATOI TN TEET, TSIAVET T4 TR
RICLT ey 7 M elEETHES. BHICRTT
BTENTEET,

IRTDISTALV%EIEFI5T 1 TICLTPro Tools®F0O0

I bERLKICIE:

1 Pro Tools . [T7IL] (File) > [TJOY T heR<]
(Open Project) ZiERL X9,

2 ZyyvaR—Roavzr k- UXNT, HNOT
oYz y FEERLE T,

3 ShiftF—Z#ML74AMN5 [B<] (Open) 27 Vw 7L
£,

TRTCDISTL VT IT+¢7IcLTIOV Y MEREZE

T, MTFOLnFhhZEiTVET :

s [T74)U] (File) > [RIEHRE LICIREEICR T] (Revert
To Saved) ZEIRLXT (v a yOEEOH),

n [T7A)] (File) > [REDEYY 3 v%ZR<] (Open
Recent) ZERL, Y7 AZa—T—FH L 70
TV MEERLETD,

Command+Shift+O F¥— (Mac D% E) izl
Control+Shift+O F+— (Windows D¥58) 7z
T FHLLIOY 7 FAHEET,

G $RTOTS AV RT IF4 T LTy =
" V&R D bIC, Command+Control F— 7%
LW 57420 % 70y 73 %0 (Mac D
#). Control+Start F—Z# LIxN S S5 71 >
Z271 w27 LT (Windows DHE). T554>
ZMEBNCT VT4 7T BHTLETEET, 12
EOTS T4 2T IT 47T B, TOIT
DWTNHDTF 1 7% Command+Option+
Control F—Z#LAMN5 71U v 792 (Mac
DA Control+Alt+Start F—Z2# L&A 5 &
Vw27 L%Ed (Windows DA,

1



tyyayeF—=9DLUK—b

[ty ¥ 3aryF—5%4>2iK— Kl (Import Session Data)
IRVRERE RS Y T& Ry THREZEHLT, HlO
Pro Tools v ¥ a >h HEHED Pro Tools 711 = &
MCT—REAVR—=bLTAT 47 ZIAE—F 5 L
MCEET, bIwIEAVKR—FLIED, A12K—F
Ty ray -7T—& (A—hA—=2a > R)—T~1
VIR E) BERTZCLETEEY, £k, ALV
TLAVA DA Ty a AV R— LT, BHEOA
TyarvEEEHRZIED, BFEO NSy JIcERrER
5L TEET,

FSyOPPSYyIDOREETOVII ML YKR—FTS

ICIE :

1 HiLwnraye s bEERLTHI D, BfFEO T 1
Vil bEHEET,

2 ROV EITVET,

e [T74)1 (File) > [ iK—K] (Import) > [Ev
37 —%] (Session Data) ZERL, 7— 2%
AVR—=bF By arEERLT [BIK] (Open)
IV LET,

s T—UAR—X + 7ZUY, Windows Explorer. %7z
& Mac Finder 5. MY « ~ R DZENT N5
Fildbow s « VXM, A VF—=+FBFTv 7%
BEODHZy gy TrANVERSY I LET,

3 tvraro [Jz—F—4'12] (Fader Gain) &
NoaY s FORELRIERZGEEE. [kyay
T7—2%A AR —F] (Import Session Data) %
TRIDFERENDZWIC, TT—F— - AV EELH
TEMNESINEMRT BTV T AR RENET,

4 [V—2X] (Source) 7 a>T,. &ErIvI40D
GILHERy T Ty TAZa—%I v T3 &
WKEo2TAYR=bT BTy IERL., BB
Swo] (New Track) Z#ERLET,

O WO Ty s ERIRT BT, DT b
© 5w yORY ST w T AZ 2 —% Option- 7 V) v
27 (Mac) £7iEAlt-2Y v 27 (Windows) L.
HHFZvy 7 UTA Y R—F] ZERLET,

A TV IFUFIEHIEL TR Pro
Tools ¥ A7 LOBAE. Y—A KT vz - U
MCHTYUR - by 7 RERENEL A,

Pro Tools O##§kRe

5 ERLIFSy o Zkic, FiBlORSy e LTAIY
R—=b52h, FLEBHEDO Ty ISV R—FT
Ry TT Yy TAZ2a—TEIRTEET, [FSY
o%—%] (Match Tracks) Z7 Vw79 2L, FU
GHIDA Y R—bE b T T eA Y R—= R T Y
7 HBc—RE R ET,

6 [MYUR—NTBRSYIT—H] Ky STy A= a—
oA YR=bT BTy IDT—REERLET,

7 (XA TUAURMAFT 3] (Main Playlist
Options) 5., V—RA « bTw 7 DAV R— bk
EIRLUE T,

8 LIAICKoTE, [F—FTA4FAT«T7H T3] &
[EFFAXTATFATYaV] ORYTT7 v TAZa—
M, AT 4T« T 7 AIVDA Y R— N HERRRL
9,

A 7OV kR RS OB EE T
WE, B=) s VAT LEDAT 4T « T 7 A
WS, Iav s e ITRTENTEET,
ZOWE, VY IENTAT 2 7137 59 RiCH
HEhizEFIcEDEITH, a—Aroraycy
F e XF94 7 « Fyvyalll@ab—¥hELA,

9 AVKR—FLET—ZD [F4L0—RIYEVI]
(Time Code Mapping) & 7> a YV EEIRLET,

10 78y 27 bOY YT )L L— b HREEZHEE.
[V—ROY YT ILL— K] (Source Sample Rate)
Ry TTwT e AZa—TY—R-kyyarohy
TV L— b EERLE T,

1M YRy yarhbiireT ROy TAY
R—b92iCiE. [FYR | \F<v I (Import
Tempo/Meter Map) # 7> a Y EEIRLET,

12 V=R -y rarhbilg A Y R—Fg2 &R,
[#85~ v 71 (Import Key Signature Map)#+ 7> 3
VEEIRLET,

13V—R-bLyaryhov—A—bXEY—Or—
varvEAYR—br3BIF, [N—h—/XEU—0O
r—2 31 (Import Marker/Memory Locations) %
TyavEBERLET,

1474 Y FURRZA Y R—FT5IC3. [DrVRD
#m] (Import Window Configurations) % 7' =
VEBRLET,

15 Pro Tools HD TV —R - v ¥ arhb A7 TV
BEEAVR—PbT BT [NM1ITURE]
(Import Mic Pre Settings) Z#RL %9,



165¢ 7 L5 [OKl 22y 7 LEd,

17 AF A 7RI —FRAVY ) F— b5 L X3,
AFAT T 7 A VRS BIRFRRLET,

A VE—RLERS Y I DY =R AT T AU
TERVEER, SET27 7 F T b -7 8AH
FEDTOY 27 MEFENTORWER, A ¥ R—
NUTe NSy ZEIET 5T 4 TR IR0 £

RSy J& ROy TEEICEDIEYYIVD
L IiRk—b

tyyay e TrANVEFIEOT AT 2 MRSy T
LT, A—F14-T774), €54 - 77 1)L, MIDI
T7AN, VT« T)—TF+T714)b, REXT7

A, ACID7 74, bIv o, wvray -F—4&

DA VKR=FEARY BT T ENTEET,

o LwyavEIIYT - UANIRTIVITEHE, FD
tyyaryDOITXRTDTV Y THA VR—FENET
(Fow IR AYR—FENELTA),

e ProTools DhT v Uity ary-Tr7A)VE Ry
JUT, b0 IBAVR=FTEHENTEET,

e Pro Tools®+Zw o « LAY A MYy Y a vk
Kowridre [Lyyarys—2FA4YR—1]
(Import Session Data) %1 7HIMHE, A 2 R—
bRy T EBERSHRTEET, AV KR—b L7
twyay-rF—=x2& OV rOERALTA VI
tyvarERray FUMEN SEAThET,

rSyoEZOMDEYYIY - F—HERSYSIR& ROYT
LTAVR—bMTBICIE :

1 T—UAR=R + TSUTRZHEET,

2 DLFD&EKSIC, Pro ToolsDtwyar«TrA)l,
AAF > — VLV A £ E OMF ¥ — 7 LV A%z BIE
DTV MIRSvFLET,

e MEDORNTWIICRIY I L, ZDLTYIDT—X
ZEHEEZLEY, ShiftF—ZMLAENSRTvIT
e, BEDORS Y7 « TLAVARDNA VR—-FE
Nrbsw s« TLAUZXMCEEHDO EJ (Shift
F—IZ&oT [kyvarvi—2EAVR—1] A
70T DOFFENERNCIRE D £9),

o FEEY 4 VY RUDZENTVABIGFRIC RSy F LT, 4
R—=rT2Lyvray - F—2HAOHR T v 77lE
RLUET,

o [Lvyarysy—%%12K—F] (Import Session
Data) A 7Y avERELET,

#%3E: Pro Tools®70O0Y 1o b

70919 bOIREF

Ay MIBMLTVE0I DO L —F —NEH
NEZET7 v Ta—R$3L, ZO7aY 7 MBMEES
NET, INTOEENEDT v Ta—Re Ry a—
RAEITENZETC. B—H)b - Fyvaldid,. B—
JIVOERER =757 R« N—= 3 VHMEN AR
FENET (Mo —YP—RHFHELIN—T 3 »EE5H]
KFEENES),

tyYaveE’0vz I bEULTIRETS

Pro Tools Ci&. vy arvoav—E27 oy 7 he L
TRIFT AT ENTEET, Lyvaryzuayz s b
ELTfFET BT kickh, BifFDYy v aryzTrn
VU MNIEBLT, AVIA AT RL—vavikE
FOTENTEFET Gty yavidk, BREHELT
HHTEET),

twvyarvoav—E2raY sy b LTIRET BRI,
HOYUTENTWVEAYTAY s ARNL—VORE LAl
MR e i IR 2 R T 2R ELRH D £3, &AW,
YA RXDKERT 7 A IVHD LK —EHDI—F ¢ F 1513
BRIy T THEXEZITIHBEE. ZhbDy
Vw TEFEETHEEBEIDLET, THHOL Y
2—2y MEFROMENIEFISENE DO TERVED 1.
YA ZXDKERBRT 7 VDT v 7T a— RICKEAD
MRGEENHOET, YA XDNEBRT 7 AN Iy
TO7yTa—REXY va— K&, R ERRL T
TLET, @HEE, IRXTORBET LAV AN 2HET S
IR, IV ITDRAAL Y - TLAV R M EHET
LREITHATY, WRERRO RN HEEDEEHNTND,
twrvarveEIaYs s b UTRET 3 C LR BEID
LEYT, 25932k, avzr ML T
WEITRTOLI—YP—DEERHEA YT 1>« A b
L— VB OHHNC DR T,

tyyarvodE—%#70J19 bEUVLTREFETDICER :

1 WOy yaryz7adz 7 e LTHMEST ST
HOMENFEITVET (e 28, /OBET 7 A%
Yy g VhSHIRT S, YA XDKERT 7 A IVD
—HEIEBBT BTy TEHET S, TEOMEE
EITVET),

2 TuYal PNTREILES NIy VRITEERL
ESCENCES =98
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3 Pro Tools T [T 7)L] (File) > [Y>->/] (Sign
In) ZFNL T, Avid¥AZ— - TAY Y Mca s
AYLET,

4 [T7)] (File) > [OE—%1{R#F] (Save Copy In)
ZERLE T,

5 [a¥—Z%fif7] (Save Copy In) XA 70T, [T#5—
<Yv KN (Format) % [ZOYx% K (Project) 1<%
ELET,

Save Copy In...

Format: | Project

Session Parameters

Audio File Type: (BWF (WAV)  ~| Bt Depth: Fader Gain:
— ) 16Bit 6dB
Sample Rate: [44.1 kiz 125 h
O 248t +12dB

Enforce Mac/PC Compatibility
| Limit Character Set

() 32 Bit Float

English (MacRoman) B

Items To Copy
Audio Files Session Plug-In Settings Folder
Convert to Specified Format Root Plug-In Settings Folder
Don't Copy Rendered Elastic Audio Files [J Movie/Video Files
Main Playlist Only

Selected Tracks Only

O Preserve Folder Hierarchy
O Session Fade Settings Folder

Root Fade Settings Folder

("~ Cancel ok |
tyyavOIE—&=70J10 hEUTRE

6 Tyyay - \SAXA—FITHRERERFEELET, HEK
MEE& AN L—YHElEHiNT D, kyravk
Tav s M UTIRET BB, > V- L—b
LBy b T TRRNMEETRET 2 L2 BEID L
N

7 JAE—92ERZERLET, Ltvrarvxodx
IR LTIRIEST 37200, S RTDA—F«4F-T7
AIWHREINETH, TV TIKDVTIEAL Y -
TLAVZAMEIDMEENE T, LY RV TEh
LT AT YD « A—=T 1% « T7AIUTDNTIE,
av—LAhnC tEBHDLET,

8 [BIRUIEMSvIDH] (Selected Tracks Only) + 7
YarvEAMCLET (TR,

9 [OKI Z7Uvw o7 L%9d,

14 Pro Tools D#rHEsE

JOJxohetyyavEUTIRETS

Pro Tools Ti&. Yuyz 7 hDak—%tyragrk
LTRETRTENTEET, Aoy -Tavzy
M TOMEENRE T LIE, ZO7ay 7 b ety
velLTta—hVic7—hAT L, xO7avsy b
HIRLET, 995K, AvidZVTUR T H
UYRDTTYR e AR L—VHEBERNT S ENT
EET,

JOYzI bOIE—ZEYYaVELTRETSICNR :
1 ATy 7S 2N TOEBEZAKRE G A
TLEY,

2 [T74)] (File) > [OE—%{®#Z] (Save Copy In)
ZEINL, [a¥—%2R#17] (Save CopyIn) %171
7T [T#—<v K (Format) % [y 3> (&iN]
(Session (Latest)) IZ&RELE T,

Save Copy In...

Format: | Session (Latest) -

Session Parameters

Audio File Type: |BWF (WAV) | Bt Depth: Fader Gain:
_ ( i +6dB
Sample Rate: |44.1 kHz = Pl
© 248it +12dB
Enforce Mac/PC Compatibility ) 32 Bit Float
| Limit Character Set
English (MacRoman) =
Items To Copy
Audio Files Session Plug-In Settings Folder

|| Convert to Specified Format
|| Don't Copy Rendered Elastic Audio Files
| Main Playlist Only
Selected Tracks Only

|| Root Plug-In Settings Folder
Movie/Video Files

|| Preserve Folder Hierarchy
Session Fade Settings Folder

|| Root Fade Settings Folder

[ Cancel ok

JOYzf hOIE—ZEYyYaVEULTRRE

3 Byyay NSA—FIHEREEEELET,
4 JE—93EBEZBIRLES, A—F«74 - T7ALE

L—E— - T7AI/ETH - T7AIIEHTIE—E
N2 LIERLTLEE,

5 [OKl 22V vy 7 L&Y,



JOJIIPDRIF—5

Pro Toolsicix, AT 27 DA ZT—XR « £ 2 AN
TR— T4 Y RUPHEINTVES, TOY 1V Ry
EEATRE, By arDARAT—R (T—T 4 A,
IYRYEa—%— YT L—bk, Evb - FTTA,
BRE) ORRPBEZITI LN TEET, —iHD
AV b ART—RIIFREMNT, FEIT B L
BTEEBA, AR ARXT—R A VARG Z—
WKERENZ IOy 7 bTEEOE#HIE, ZREM
T—RTT, AZT—RIF, Tavzr &L elfifE
ENFET, SOV T bDORAXT—EIZ, Pro Tools D7
SUY T VRIICEERENET,

RAIF =G « A VANRI 5—ZHLK[CIF :

s [D4 2V RY] (Window) > (X5 FT—5 14 VARG 5 —]
(Metadata Inspector) DJEICERLET,

e 0O Metadata Inspector

Project Name: | WhirrledBeat |

Project Owner: JurgenRawls

Title:

Artist(s):

Contributor(s):

Sample Rate: 44.1 kHz

Bit Depth:  16-bit

Location:

Date Created: Mar 21, 2016, 8:48:56 PM
Date Modified: Mar 24, 2016, 6:18:25 PM

BPM: 99.0066 bpm - 120 bpm

OV MERDRRENEX I T—4 - A VARG & — -
U4V RY

#%3E: Pro Tools®70O0Y 1o b

RIF=G e A IANTIT— D1V RD

ARTF—=R e f VARG R— T ¢ VY RTICIE, TV
7 M R FOEMNEREINE T, WETHER A
2F—=2EHNUE, TREADART—2EHDET,

J0Yx Y & (Project Name) 71z 7 FD#ii
PERENET,

JO0Yz Y hABEE (Project Owner) 7Rz 7
FiAHEDARIDERRENE T,

1ML (Title) £y > arrmyzy b LiERlo%
Wiz2A MVELTATILET,

P=F4Ab (Artist(s)) tvarvEkidE oy
DT =T 4 A DI AN LET, BEONETE
ATBTENTEET,

JY hUE2—%— (Contributor(s)) > >3 v %
RE7ave s hoary by Ca—X—0%HEATL
9, HHOANiIZATITEI LN TEXT,

B JILb—b (Sample Rate) v >3 v ki
OYxy hOYYT) - L—BERENET, BT
L—hiE, V= AR—ATEERTHTENTEET,

Ev r5FTJR (Bit Depth) v g vkl myx
JEDEY b+ FTADFRRENET, Ev b FTRUE,
T—=Y AR—ATEERT BT ENTEXT,

1BfF (Location) vy arvFEkid7uyes rH L
a—F 4 VT ENEFEASILET,

{ERB (Date Created) v > a v i@/ mnyrs
FOERHRNRRENE T, ERBRE, T— 7 AR—2X
TLERTBTENTEET,

{2IEB (Date Modified) v a vz nyz
7 FDBRMEFHEEDNERENE T, BERIE, V—7 R
NR—ATELERTBHENTEET,

BPM tvyarvEhkid7/aye s voFURERIZT Y
ROHFIPAM 1 il 7z 0 O TERENE T, BPM I,
U= AR—ATCTIRE L TERTHILETEET,
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JOJ 1Y PERAUS

Pro Tools Tid., —EIfF¥TE5 70y MI1D
ZITY, [FOVzI hERUS] (Close Project) I+
vV REHITT S L. MEERD Pro Tools 70V 27 M
BTULETH, Pro Tools 7 7V r—a VidBEE L7z
FFEICRLDET, TuVzV EHLLS TR E ZFD
IaYrl N ERMET B0 Tary S R RENE
I, Tavry b EHUSHNC. [RF] (Save) O¥
v RFEKIF [BE1ZHITRET] (Save As) O~V Rz
HHLUTEENRZMFT 5 e BEIv LET,

JOYz I MERUBICE :

n [T74)] (File) > [JOY U h=BIU3] (Close
Project) ZiERL X7,

0919 hEDEE

HAOWHIELTWE 7Oy s hOAHIAEET BT L
MTEET, 2L, XvvaR—Fo [Tuvzr ]
(Projects) 2 7 CTHWTWE BT 27 DA ZZEH
THZLETEETA

090 MREEETHICIR :

1 Xy¥yaR—FK-94 Y RYT [JOVII N (Pro-
jects) X T FIRLC, fE¥EPOTOY 2 s Mk
ARUZET, Pro Tools N3 TICHE L TV 2 HER.
[Z74)U] (File) > [FOY o +&ERM<] (Open
Project) ZERL T, Xy aR—FK T 1 Y FUD
[ZOYx o N (Projects) 2717 72 ALET,
Command+Option+O F— (Mac D% 1) X7zl
Control+Alt+O F— (Windows D&) 2 LT,
RUCEEZRITT 5 ENTEET,

2 Javz b VA MOLERIT, AnizZEELznTH
VI FDORY T Ty T e AZa—%I Vv I LET,
Proj_RC

Quartet_Andante
Today, 4:36 AM

Rename...
1

WhirrledBeat "5 Remove Local Cache...
3/22/16, 12:58 PM Delete...

Open Latest Auto-Backup
FwyaRk—RTTIOY I NEEEE
3 [ZFIZE] (Rename) ZERL T,

4 AATOIPERENED, HLLTaY s Mk
ALET,

5 [OKl 27Uy 7 L&Y,

16 Pro Tools D#rHEsE

O—=AJb « ¥+ v 1 DHIER

BT AEWEEO ey 2 7 o [O—AlbF vy
>a%#2Y7] (Remove Local Cache) <> RZz{#
M32E, a—Hh)b - VAT LOA N L—I 8% it
FTBREMNTEET, B—H)b-FrvazflfRLTd.,
9 RDTOV T MCHBIEH D F . 5l ERE,
7SR TAaYey NERIST R ENTEET,
FUIAVDOMYAVIAT HT Y EDTTT R A L—Y
M, WOTE AV MEEET AT ENTEET,

OV boO-Al - F+ vV 1ZHIIRTBICIE :

1 XyyaR—F-Y4YFoT [FOYY K (Pro-
jects) 27BN T, MF¥EPOT Oy 2/ M ek
RUET, Pro Tools WS TICHME L TV B E X,
[Z74)] (File) > [FOY o h=FI<K] (Open
Project) ZERL T, Xv¥aR—F- T4V FUD
[ZFOY 2 K] (Projects) 277 7 AL E T,
Command+Option+O F+— (Mac D5 &) £7213
Control+Alt+O F— (Windows D35 &) Z#HLTE.
M CEEREITTZ LN TEET,

2 /avz sk VARDOAERIT, a—A - Fx vy
varEELEWTaY 2 FORY TT v T - A
Za—m27Yw I LET,

Quintet_Largo
Today, 3:32 PM

~) Proj_RC
Today, 11:46 AM

Quartet_Andante
Today, 4:36 AM Rename...

Remove Local Cache... s

WhirrledBeat
3/22/16, 12:58 PM Delete...

Open Latest Auto-Backup
FyvyaiRk—RTO—HI - Fv vy aziliR

3 [@—ANLFvvazEIUF7] (Remove Local
Cache) Z#EIRL X9,

4 TuyTIHRRENS [HIER] (Delete) 227V v
JLET,

TaYVr 7 VORI STR - TAaAVhEREND
TEWFERELTLIZE LV, Pro Toolsic &b, Ymvx
JhOa—h)l - FruyalRENETH, FS5Y
FLoooyz ) MNCEEIHODEA. 7ITUR T
AAVEIVYITEHE, Talzl bDAT 4 THE
vra—RENh, Yy boa—hl - =T a v
LA UIA Y e N=V g UHEENET,



70J 1Y PO

TuY V7 FTOEEDRET L TRENGEIy IV AT
JAR—FUES (Ffzid. [OE—%R%] (Save Copy
In) ax Y REMEHLTCTaY 7 ey arel
CT7—HAT LED), To7adz s FZHBLTHE
WERA, TV MRS Z KD, fiDa—
PF—IMERATEF 5 A « A b L—IEE Rk %
TENTEFZT, EENTOY 7 FEHIRT B
RyyaR—R -0V RUEFHLED,

[Tz F7%2iHZ%E] (Delete Project) I~ > 2l
LCHIBR L7z T B Y 27 M 2IGICRT T EIE TEEE A,
fOI—F—AFELTVWETmY 2y~ (HFRSM
HeLlTasRL—yaryzffoTwns7 a7 h)
ZHIBRLIZGEG., 2070y s Mh5ESHEHYIR
TNBREIT. TuYV T MBHIBRENZ DI TEHD
FEA, TRV LY FOFEE LMOBINE R, FI&HE
ZDOTY = NIRRT TEMNTEET, 722U,
HABAELTWE7nY 7 MEHIR LGSR, 5%
RICHIRENTEILTE RS EL X7,

oYz bEHIRTBICE :

1 Xy¥yaR—R Y4V FUT [JOYTI KN (Pro-
jects) 27 &R T MO T OV 2 7 R
L %9, Pro Tools B9 TICHM L TV 3HE .
(7741 (File) > [TOY 2 ~%ZR<] (Open
Project) Z#RL T, v ¥ aR—F-U sV Ry
@ [ZOYz o KN (Projects) 2717 VA LE T,
Command+Option+Q F— (Mac D% H) £72id
Control+Alt+O F— (Windows D) 2L TH.
RUCEEZRITT 5 ENTEET,

2 vzl k- YRALOLART, Bl TeY
JRDORY T Ty T e AZa—% Vv I LET,

Proj_RC
7 Today, 11:46 AM

Quartet_Andante
Today, 4:36 AM Rename...

WhirrledBeat Remove Local Cache...

3/22/16, 12:58 PM

hDeIe(e...

Open Latest Auto-Backup
FvyaR—RTIOY I MEHIR
3 [HIFR] (Delete) ZHHRL F9,

Pro Toolslic &> T7uy 7 FHHIBRE N HHL T
DA L—YDRERBEERTIN— VT —IDEH
nE9,

#%3E: Pro Tools®70O0Y 1o b

95U KNS5O0V MEETTD

a7 bou—n)b - FyvaZilRLTE, 75
T RNSZFDOTAY 2 N eEILT AT ENTEET,

I59RpS5TOY I MEETTBIC :

1 Xy¥aR—F-Y¢4YFUT [ZJOYI RN (Pro-
jects) X7 &R T MO T 0V 2 7 M 2R
L %9, Pro Tools B9 TIZHKM L TV a5 EE.
(7741 (File) > [ZFOY 2 ~%ZR<] (Open
Project) Z#IRL T, Xv¥ah—F-T0 Ry
@ [ZOYz o KN (Projects) 2717 7 EALE T,
Command+Option+Q F— (Mac D% H) £72id
Control+Alt+O F— (Windows D&) ZIL T,
RUCEEZRITT 5T ENTEEXT,

2 7Yzl k- YXLOAWT, EillenTnYa
JhDIIYR - TAAVEI) I LET,

Quintet_Largo
Today, 3:32 PM

7<) -—

Proj_RC
Today, 11:46 AM

Quartet_Andante
Today, 4:36 AM

WhirrledBeat
3/22/16, 12:58 PM

FyvYaRk—ROISIR - P4V

Pro ToolsiC & D GEIRLIZTOY 27 hDITXRTDT—
ZW, VI RNV ATLALEOO—H)V c Fryia
KRy va—RENET, XU ra— ROETRIIE.
Tavzy MHOGRICERRENET,

3 Respectable Citizen (Storage| 19%) v

CREATE BLAST_proj N
Today, 4:02 PM
RECENT Quintet_Allegro \/
Today, 4:02 PM
PROJECTS
‘ Nocturne Qv

Today, 3:41 PM

Fyyaii— ROFYO— RETREA Y V7 —5
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ERMOBEINYIT v I =ML

RHOHBNY 77w Ths T uy e 7 BT
i3, [RFOBE/NY o7 v TI=RL] (Open Latest
Auto-Backup) a< Y REMHALET,

0V FOBRFHMOBEINY I7 v TEMLICIE :

1 Xy¥yaR—F-94 Y RYT [JOVII N (Pro-
jects) X T FIRLC, fEEPOTOY 27 Mk
ARUZET, Pro Tools N3 TICHE L TV 2 HER.
[Z74)L] (File) > [FOY o +&ERM<] (Open
Project) Z3EIRL T, Xy ¥ af—F U1y
@ [FOYz o K] (Projects) 2717 7 ALE T,
Command+Option+O F— (Mac D% 1) X7zl
Control+Alt+O F— (Windows D¥58) 2L TE,
RUCHFZRITT 5 ENTEET,

2 TaYzs b VRNOLEMT, BFHOATINY
T TR TUY L RORY TT Y T e A a—

27w LET,
Proj_RC
Today, 11:46 AM
Quartet_Andante
Today, 4:36 AM i
~) WhirrledBeat Remove Local Cache...
3/22/16, 12:58 PM Delete...

[\ Open Latest Auto-Backup

vy am— RTERHOBEE/NY 77 v TZHEL

3 [BHOBE)/N\vY U7 v TZR<](Open Latest Auto-
Backup) ZiERL £,

Pro Toolsic &b, Ayl FORF DNy 7T v
MhEET,

18  Pro Tools D#rHEsE



BAE =T 1AM FyybeOsIRY

T—=T A AR Fxw bk U2 RUZMHLTHMODPro Tools T—Y—ZHKRRKRL, YO0V 7 MIEHFLTIAIRL—
TavETICENTEET, IFRL—Yay - TabA0ETHIE, FFA - Fv v MEREZMH L T —
P—e a7 —varkEEDET, 7—FT 4 AL FX v b U0V ROBTO—T 4 VT - T4V RITY,

T=F4 AN Fyryb -9V RUEML (FLREALS) K& :
1 Pro Tools Z#2&E L %9,
2 ZyyaR—R-90 Y RYZHiHTEH. [T74I] (File) > [Y14>4>] (SignIn) ZFRL T, AvidIAZ—+

THYYMCOATAYLES 7T—=T A AL = F¥ v b Ut Y RUIKT 7 RATBITE, YAX— T HT VM
YA VAT ZRENDHD LT,

3 UTFowThhZEITVED,

e [« FD] (Window) > [P—F X b Fvw k] (Artist Chat) ZEIRL X,

e Mac DE1d Command+Shift+= 35) F—2 L. Windows D¥;&1d Control+Shift+= (55) F—Z# L £ 9,

9 (a]
Search... Q TheodoreGadamer

Contacts
Notifications

Notifications

» Projects

» Chat +

P=TAAN - Fryb-O4VRD

BAE P—FA4AN - Fry b -I14VRD 19



70771 ILOERE

HMDTT—T 4 AL Frwv b - VRFuZHL &,
TaT7 7 AIVOREEENERENET, HyDO S 1
T ANVIEREZERLTEL &, D Pro Tools L—
P—WRAvidT + L7 ) THEIZOEREMRRKRTES
X2k ET,

00

== & A
Contacts.
Profile
Notifications
v Chat #| F¥  Wwelcome tothe Artit Chati
" Before you begin collaborating please set up your account.
Setup
Display Name must b thvee or more vald characters
Jurgen
Ravis
us

P=T 4L - TOT7A)VOEREEE

(&4l (Display Name) 71—V FIZATIRETT
(COZMPMID L—P—ICERENET) , DT 1+ —
WRETRTA T a > TIMn, ANLTHL &, o
I—P—MAvid 7T« L7 M) THRT=ONEHR%Z EEIC
METEHX21CEDET, 7077k, VWDOTE
WET BT ENTEET,

20 Pro Tools D#HkAE

P=FT14AN - TOT7 7L IV ERETHICIE :

1 7—TF 4 A F¥v b U VRUDhEMICHS
TNZ— T AV Yy 7 LT [FOT7A)]
(Profile) Z#ERL £,

@ Offline
Profile o

FPING— - XZa—=TTOT7 A IL7EER

2 a7 7 ANVOREWE T, 7—T 4 A TO7 7
ANVOTEHREHEHLUET,

u Respectable Citizen

Profile

Setup
Do you want to appear in results when other users search Avid directory?
Yes  [JNo
( Respectable Citizen

| Respectable

[ citizen

J
J
J
[ san Francisco ]
[ california ]

J

[us

- cancel [~ Save ]
=T« JOT7AIVOREEE
3 [®%=] (Save) Z7VUv 7 L%9d,



iEfEk

T—=T 4 AN Fxv kT2 RuO &S] (Contacts)
27T, HEEOBIMPHIBRIZT Ta | (TEOH
FETFAM - Fr v b EFI5C2LETEET, Avid
TA4L7 MY THLWEREZMRT S EE, a3
Zh—a v EED NP —CEHE X — IV EEET
5B TEET,

EfESEDEM

EREZENTSIC

1 7—T4AbFvv b -T2 RUOLEMD LEEE]
(Contacts) #227 Vw27 LE9,

00

Search. Q BT surgenRavis

Contacts. My Contacts Add Contacts

Notifications

¥ Projects Name Location
228 WhirtedBeat Write at least 3 characters and press enter to search
¥ chat *
2 Bruce Bennett
2 Respectable Citizen

LEfgscZEN] (Add Contacts) #7727V v 7 LE 9,

MERT 4 —IV T, 2—P—DERLDEAD 3 XF
L EZRANTBH, 5282FEA—)V 7 RLAZE AN
L T. Return ¥— (Mac D#) F7zid Enter ¥—
(Windows DY) ZHL %9,

4 BETZ22—Y—DT7—T 4 X+ T0T 7 AIVIE
EENTONUZ Avid T« L2 BU TZEDOIL—HP—H
oMb xd,

ST DIENN
2
3

D JurgenRawls
My Contacts ‘ Add Contacts
bruce x
Name Location
B sruce Bennett Pacifica, CA, US 3
RTB CERBEZENM

5 I—P—DFRRUDLEMCHZTIA (+) KA V%
7)w I LET,

BAT  P—TAAN - Fry b -U1VRD

6 HHREL LTCBMMTA1I—Y—Icid i Ay b—
ZAJILT GEE] (Send) Z2VU vy 7 LET,

JurgenRawls

My Contacts ‘ Add Contacts ‘

-4, Bruce X

Name Location

F 7 sruce Bennett

Pacifica, CA, US [+)

Add to Contacts

F 1 5ruce Bennert

Do you want to colaborats?

[ Gercet | Rad ]

BEEIC X v E—IZEE

7 AV —I%%E LIn#E e —Y &, e LT
BINENS T L BERF RIS LB ET,

Avid T« LI PUICERENTLRLEREZENNT BICIE :

1 7—T4 AL Fvv b U RUDEMD LEEE]
(Contacts) Z#227VUw 27 LE9,

2 [E&S5zE] (Add Contacts) #7227 Uy 7 LET,

3 SR LGB LW =P = Avid 74 L2 b
DIIC RO B RV AE. ZOL—F—0 Avid ¥
AR— - THYY NDFRRIREA—)L + 7 RLAEA
HLET,

D JurgenRawls

My Contacts ‘ Add Contacts

{ TheodoreGadamer@gmail.com x
Name Location
Nothing found. Please change your query and try again.

Or...
Invite someone to join the Avid platform and collaborate:

$ &

EX—=)U - 7 RUATERFTZENM
4 [EEFZEFE] (Send Invite) V> 7220w 7 LET,

HFR e L —Y =i, MR L L TRENT 2 7O DHFFE
A=V EENET,

< 1 &%

o1 —F—Z2H Ay OEEIEL LTERT L. D
A—PF—eFry hELED, TVl MCHEFELT
AR —arZiTHTENTEREIICEDET,
Fh, o —T—h 570 7 FA\OEREEZIF T
AT RL—2areff52 b TEET, HKLEZHIR
ITBHELETEET,

21



ERRERTIBICE -

1 7—T A4 AL+ Fxv b U Y FUOEMO LEE
%t] (Contacts) Z27VU v 7 LEd,

2 [~wrigt] My Contacts) X 7THERRENES
FERENTWVIGAE. 27270y 7 LTIV,

[T TheodoreGadamer

My Contacts ‘ Add Contacts ‘

Edit #

Namer Location

u JurgenRawls us

A Respectabie citizen San Francisco, Califonia, US

[ E#&5E] (My Contacts) 57

3 LWINOOEIEE XTIV I )y 79 B L ZOMHE
HEeTFAL - F vy F2ITHTENTEEXT,

EREEHRTBICR :

1 7—T4ArF¥v U Y RUDEROD LEE
%t] (Contacts) Z27 Vv 7 L%9d,

2 [xrHEiEgse] My Contacts) X 7AERRENET
FERENGWVGAE, 2727V v 7 LTI,

3 [~Ekg] (My Contacts) A > DH FRED R
%] (Edit) 27V v 7 ULET, HWE EdiY &7
AAVDENFICEDLYET,

4 HIBRUIZOERBIEOAICI T R - =Y )V EIBE L
9, YA FRidE (O ARRENET,

5 YAFAils O 27w LET,

JurgenRawls
My Contacts ‘ Add Contacts
Edit ¢
NameY Location
Bruce Bennett Pacifica, CA, US
Respectable Citizen san Y IRSIEOESTOITCONIRGES
Bruce Bennett
TheodoreGadamer New Y [~ Cancel |
N A EEEDIRE

6 [HIEX] (Remove) Z7 Vw7 LT, @& EHIFRL
9, HIBRLAaWEaE, [Fv+>t)L] (Cancel) %z
70w LET,

22 Pro Tools D#HkE

TaYr I hTOASTRL— g VORFA—IVEZE
95 &, [@EA] (Notifications) & 7ICZ DBHINER
INFET, aSRL— 3 VOBPRHE, KBTI BLD
HETECLLTEES,

70V PTCOIASKL—Ya VORBFERDELBIEST

BlclF :

1 BNZEZETEE. T—TA A Fryv Uy
Foo [GEA] (Notifications) % 7 DHEMNCETH
FRENET,

Contacts
Notifications (1]

1 HDEA]

2 7—FT4ALFx vk U Y RUDOEMD LEH]
(Notifications) 27 %271 v 7 LT, @HIONAE
FRUETD,

3 WHIOWAZMER L. #7232 2 MEE S 272

WiLEd,
Search... Q o S—
Contacts S
Notifications
Mar 25, 2016
> Projects JurgenRawls  7:07 PM
! Has invited you to collaborate on "WhirredBeat" [ ]
Please collaborate on this project, it could really use
» Chat + your aesthetic input.
Yesterday

JO0Y 1 NTOISKRLU—Y a v OBEHER

4 BREZIZGEIRGOF 2y I—0  RA V%
Vw7 U, W REGT B8R0 [x] RaY
Z7Vw I LET,

5 BREERTZ L. ZOTOV 7 MHRX Y ¥ 2 R—
FED [FOY 1O K] (Projects) YV A b CREAATAE
IR0 E9,



Javzo b

[ZFuYxs k] (Projects) 271l BIEFIGEL T2
JavzrheasRl—rarEiioTtwasaya
7 bW IRTERRENET, [FuY 22 M (Projects)
RAVTCE, aFKRL—vary - bSo¥rvary-ny
DFREIERTREYOEZ D, BRLETaY 27 F D
aASRL—ya v bW Ivary-alEERLIED
fhod eI ——%TaY 7 MTIHEE LT:7$
L—yavzEi{iolzb, ayz/ v casRl—v 3
VETOTVWERAI—Y—LF ¥y vy FLIEDTHIEHT
X9, UR F@?‘EELL#D/I& FERSOLED,
Javz M HBHLEDT R L TEET,

JuYr s Mo —F—E2EFLED, a5 KRL—
varvEToTVEIA—Y—ZHIRLIZD TE5DII,
ZFO7aY 7 OFAERFTITH, @D X Y —
VDRV R, TI—=THATDRA Yy =YD D H
DI, IRTOATRL—Y gy - a—P-—NMr5C &
WTEET,

P=F4AbFvy b4V RUTIOI I FERTITSD

ICI& :

1 7—=74AF-F¥vb U rFUokfilo (70
Yz KN (Projects) 27722V v 7 LEd, Iadx
Z bk URARD IENTOEHAEER. VA MR
g 2e. HOMVFAL VSTV 7 heas R
L—ayETo>T03 70y s 7 T RTEREN
9, SOVl - UR MDD FfehFoR L ERHE
Y0 Z BId, [FOYII N (Projects) DM
KRRENTOEEMAEORE 2TV Y I LET,

2 BHHOTBY 7 heEIRLE T,

0.0

u Respectable Citizen

,lt Quartet_Andante EIE §

Search... Q

Contacts
Notifications

JurgenRawls ¥ TheodoreGadamer ¥
¥ Projects ‘

222 Quartet Andante

= Hey Theo, can you review this 10:43 PM |
312 WhirrledBeat arrangement and let me know what you
292 Proj_ RC think?
228 Le Charm
292 first project
322 second project

222 thrid project

Respectable Citizen has invited

TheodoreGadamer to join the project 1o:A0EM

TheodoreGadamer has joined the project. 10:46 Pm |

+ ~
> Chat Sure, I'l get right on it. (22) 10:46 pm|

|
‘ ®

[Quartet_Andantel 7OY 7 hHERENTOI T b
Ea—

BAT  P—TAAN - Fry b -U1VRD

3 BRLZ OVl hOF vy bREREIN, 2D
DYIﬁh:%MLTwél P—tasRL—
chIUYIvay - adhEREINET, T
@?V/Ff\ﬁﬁﬁi—ﬂ EIaY 7 MR
TEHENTEETD,

JOYyzI b« Fvry bOFEIY MO

TaVr 7 bOF vy MlE, TRV MIBINTE
21—V —DEMHETS HOayta—)Le, Ja
Y hDasKRL—vary bSUYsvaryend
DFREIELREYOEZ ZTzb0ay v a— )V AE
ENTVET,

BINEDORT | IERR JSKb—vav-
NSy ovay-.
JOJzOhE OJDFRT | FERR
'L Respectable|Citizen
3% Quartet_ Andante =N §
A |
genF v [T v
SNER SR L—Y—%

BMERAX=21—  JOYIUNIER

[Quartet_Andantel 7OY 0 hHERENETOI T k-
Uk

aASKL=—vav-.- SSyY¥IvYay -0

ISR L—yary.- hSUPFIvary-adicid, S
Tl bOFEZETXRTOSIMNED T I IENT
NCERENFET, conFiF, Tavc7 Mcwd 3
ITRCDEFENEE T F VT T E5E5IERHTT,
EL, aghERTTay 7 hOF vy bHRIZL
{55581, B Z2ELRCUTHEVER A,

23



JOY o MOASKL—YaY - NSY¥IYay .00

REEIRTENDEZBICE :

1 vz rnasRL—yvary- bSUP sy g
Vel EERTBICIE. ATFRL—vay e IV
Prvay -adORREIELRREYOEZ S0
TAAVETVY I LET, TOTAAVHETER
ENTVBHAEER., OFHhERENET,

,ll Quartet_Andante =] §

JurgenRawls ¥ | TheodoreGadamer ¥

Mar 22, 2016

Respectable Citizen has created

Quartet_Andante. dsapu

Respectable Citizen has shared tracks: Chord
Symbols, Meter, Markers, Key Signature, 4:54 PM
Tempo.

Yesterday

Respectable Citizen has shared tracks: Violin I,

. 5 5:17PM
Violin I, Viola, Cello.

Respectable Citizen has invited JurgenRawls to
join the project.
[Quartet_ Andante] 7O0Y 1 hHRBIREN, ISR —
yav . hNSUYIYay - OJpfRRESNTVS IOV Y
NATP N

5:25 PM

2 JuvzZr0asRl—yay bSUPsvgy e
O/ xIEFRICT BICE, ISR L—yare-bov
Prvay -ndoORREIERREYOEZ S0
TAAVETVY I LES, COTAAVHITL—T
FRENTVBERR, a IR RICEDET,

24 Pro Tools D#HkAE

EREL—Y—2I5KL—YaVICEHTS
(FO0Yz o FOFBEEDH)

BIRLETOY T FTOISKL—Y 3 VICERKI—Y—
ZREFTDICS :

1 (g a5 R L— 3 2Rk nvite Contacts
to Collaborate) 7 A a2z 7 1)y 7 LET,

Respectable Citizen

B4

Invite contact to collaborate:

Q
cst

rwardell
TheodoreGadamer

JurgenRawls

Bruce Bennett

/Theo, 1 could use you expertise on this project| 1

Z,

You can only invite 1 more users to join the
project.

Cancel )| Add
JOY I FTOIASKRU—Y 3 VIGERSEL—Y —&1G1F

2 HREI—Y -2 T B YA RT I AL EDE
oL ——ZBINL £,

3 el (AdD 27V v I L&Y,

IR i a—Y—ic, Jayz 7 hTtoas R
L—ya ViciBfE Nz e NEmEnNEd, @mzs2
Uiz e —Y—d, AFE2I52 e biEGT5C
LETEET,



FOYzI bOBNEEF v v METS

[F+vv k] (Chat) 74—V REFEHLTF ¥ v bDF
FRANEANTRE, 7OV 7 MIBIMLTWETART
DA—P = aAI2=r—varzbBTehTEET,
F v v FOFHICOVTIE, 26R—TYD [Fr v ] &
SBILTL IV, B EREMDFLELETF vy b Tl
MIBTLeTEET GELLIZ, 30R—YD Tigxr
ERREDISIIV ] ZBIRUTLTZE W),

[JurgenRawis ¥ | | TheodoreGadamer ¥

n What would you like me to work on here? 12:10 AM

n scoring? 12:26 AM
E 12:27 AM

B 12:29 AM

n | think | have some better sounding solo string sample 12:31 AM
libraries. let me try it out and i'll post a frozen track so
you can let me know if you agree.

sure, listen to what | have and let me know what you
think.

Theo, can check the cello part to check playability?

sounds good :smiley: ©
JOvzobk-Frvb
091 FENMEORTEIERTOVDER

[HH7 12z ] (Shared Project) 7 2D R,
BMEDOTRREIFRRZYIOEZ 212007 A AVND
DET, TV FOBIMEV AN (ITKRL—T g
ZATSA—Y—eTmY s MIEEDY A ) ZIEER
C§2&, 7aVz Vb - Fvy FOAR—ADED>T
R0 ET, IRNTOBMED, Avk—I%%D
WO HMFEERTZHCENTEET, ZIEL. BIN&
ZHIRTEZDE, TRV 27 FOFTEHEETTY,

,ll Quartet_Andante
o,

W
JurgenRawls ¥

TheodoreGadamer ¥

JOVzI b - Fry hTEMEY R NEIERTICT D

FAE P—TAAN-Fry b D1V RD

OV FOBMEICKX Y E—IZEETD

ZMEMDAZ 2 —2=2 T2 L. IXTOEMNHIC
Ay —VRIKETHT Ll FEDI—P—ITHL
TOBRAY L=V ZEETEHIENTEET,

TheodoreGadamer ¥
=3
BEDTOI I MSMEBEICA Yy E—IZXE

091 M SEMEZHIRTS
(FOY I bOFRBEED)

BIMFEFDA= 2 —Z2FHL T, REDZMEZTHY =
I I EHIBRT BT EMNTEET, L. BIEZH|
FRC&2DE7 1Yy FOFEHRITTY,

,ll Quartet_Andante

JurgenRawls ¥

TheodoreGadamer ¥

Message

Remoye ,
WEDOTOY 17 bSMMEZHIR
J0Y Y FOEH

IOV MIBMLTO0E0INHhDI—F—NZD
IuY I b eERETRE, Tuda s UANAD
MHET7OY 7 hOHMIC, EEOHEDEREINET,
ERENEEMRET 3ICE, To7ayz 7 boas R
L—yay-bvouv¥rvay -al iz RLET,

¥ Projects

212 Quartet_Andante (2]
212 Proj RC
212 whirrledBeat (2]

70V hOEEE
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70919 M SDiRiE

7Yz s OFHE TR BIETHBHA WOT
70V M LBINT BT ENTEET, LA,
Ty x b TOMRBIEEM T L TIOMEERTTS
BRETT,

IOV M5BT BICIR :

1 7aYz7 b URLT BHLENTRY s bR

HoVyr LET,

2 7V v Y« A=a—T [RIF3] (Leave) ZjER
LET,

¥ Projects
222 WhirrledBeat
23228 LeCham
222 Quart@VTll
m Proj_F
m first proje

JOYJ Y hhSRH

Tay s M BBHTRE. T—T A A Fr Y k-
T4V FTERyYaR—FOTaY sk YR
5ZD7uy 7 FhElRENE Y,

26  Pro Tools D#HkAE

Fry b

T—=FT A AL F¥vhe Y RID[F+ v b] (Chat)
Y rvavicid, ave b Fry bEIZEESHE
BOF ¥y b TN—T « Fv v FOBENTRTER
INFEF, Tavr sk )R NDEE LR, T—
TAARFyy b U YRTEMOF Yy N VA
FOHT D e le AFRIREERF R ZYI DB X 2 LW TE
9, FFEDF v v b« ALy RZEHFO IR E, 20D
Fyy b ALY RTCRELEAYE—UNHB5E5.
ZODF vy ke ALy RTEITINLBRIEN D BHEIC,
ZDF ¥ b+ ALy REOHINCEFHERENET,
VARANTZEDF vy b« ALy RERRTZ L, $XCT
DAY=V LEERF vy b« 7Y g VIEREN,
AL ROAHOETEIEZ ET,

Foyh-UZ D FryhO Ry
b fercd+ | BB W=7 -F vy bDBEDH)
FLLF v v hORR g1 —%
F o hCH
Fry g v MMIIER
aln
earch.. Q TheodoreGadami|-
Fe== ’ll Bruce Bennett,JurfienRawl ER
1|otifications AX. Doubis-dlck to set a topic
| Pmlsl:‘! Bruce Bennett ¥ | JurgenRawls v —
Today
¥ Chat +
219 e BennetLurgenFanis Bruce Bennett has joined the chat. 1512 Am
“ig g 4 o has joined the chat. 112AM
csl
2 Jurgenrawis
2 BruceBennett 2]
2 RespectabieCitizen €}
| o
|
Fryh UK FroyhRqY
TEAMFryb-Ta—ILE HEF EECEED
EaNACI

Fryh-Ea—



T=FAANFyvYyBb D4V RITFvry b URMERT

gBHICE:

1 7—TA4 AL Fr v b U0 Y RUDEMD [Fry
R (Chat) 27 %2270y L%d, Fr¥rvbh-UX

MLLF v v PORIG

WLwF vy b ALy R2RET5IKE, Frv U
ALOHEMCHZTIR (+) REVETV Y T DM,
RO D R ERTOBEAE. UZ N FRET S [~ H#fgse] (My Contacts) Ak TOINHD5HE
L. BAMHELTOA IOV s b asRL—  EXTNIV Y LET.
TavEToTVWAETRY 2 PRI TRREN 00

9, Fv v b YA MDD el HER ERINER Search.. Q BT Respeciable Citizen
ZYIOBABICE. [Fry R (Chat) OFEMNCER ::::::o"s 1 babbayadda I §
TNTVBEMBORE Y EY v 7 LET, e
ar 22,
. N > Projects
2 HAOF vy bk« ALw FEERLET, -
babbayadda has invited Respectable
¥ Chat * Citizen to join the chat. E12AM
00 % vavbayadda
292 JurgenRawis, Theodore...
Sebich Q BB surgenravis 2 TheodoreGadamer
Contacts Respectable Citizen, The 392 respectable chat
Notifications A;t new project ideas Ed 2 :::w,sﬂ;;a o
Respoctabie Ciizon ¥ | | TheodoreGadamer ¥ 2 JurgenRawis
» Projects 2 o
o 2 Bruce Bennett
¢
;nh:snemm cmm_m: Respectable Gitizen has joined the chat 1201 AM 2 rvardel Hi Babba! How are things?| )
i :L:::j:ama TheodoreGadamer has joined the chat. 1:01AM {EIEU;__" w I\b\‘in__\_é_nrca__ TNy |‘ . EIL—
2 Respectable Citizen
ERF+Y b
g BERIDEREI—Y—&F v FETSICR :
Shall we start a new project :musical_note: ®

1 LTFoVWInhziTnEd,

o [~rifg5E] My Contacts) VAFT, Fvv kL
FOEEL— = XTIV IV 7 LET, ZOH
Bhad—P =N TICF v v PHDEER. £0D
Frv b ALy FALRENET,

o TIX(H) REVEIVY I LTHLOF vy bR
U, Fy v MEF L EZHEELEI—Y— 2L

II—T - Fry bORRESNeF vy b - Ea—

3 BRLZF vy b« ALy RHREREIN, Fy v b
BIML TS I—Y—LaSRL—r g b UHY
Jrvay -adhERENET, 2OF v v b X
Ly BT, d@igea—y—%F+ v Mic@mlizy
Fxy D OHIBRT BT EMNTEETD,

JaY 7 hF vy hOYPS LRI, 3T RL—T g
VebhSUYsvay - adOEREEFRREYIOEZ
BTENTEET, £z, Ty Vb« Fyv v b
B LRI, BRI ——%F v MCBEFET S L
ETEET, ifLE, 23X=Yo [Tayzs b -
Frw by bo—)V] ZBIRLTIEE 0,

BAT  P—TAAN - Fry b -U1VRD

X9, ITIEF vy bARBEN TV gL —
Y—ohaE, LT vy ] (New Chat) YA b
TZOHFFAEI—P—Z2EINT B LI TEEE A,
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Searchl start new chat with:
Q
v Proj rwardell
JurgenRawls
288 WH [( ) cst
m Pr{ Bruce Bennett
TheodoreGadamer
18 firg
202 e [ start
322 second project "‘
¥ Chat *

1 TheodoreGadamer
m respectable chat room
% SkywiseTest4

1 JurgenRawls

1 cs1
II—T - Fry bORRSNeF vy b - Ea—

2 [BF#R] (Start) 227V w27 LT, BIRLUIEKET—
P—e D LOF ¥y FEBBRLET,

8.0

Search... Q
Contacts
Notifications

-
{11 Respectable Citizen

1 babbayadda B

Mar 22, 2016

> Projects

babbayadda has invited Respectable

Citizen to join the chat. Zi2AM

¥ Chat +
2 babbayadda

322 JurgenRawis,Theodore...
2 TheodoreGadamer

328 respectable chat room

2 skywiseTest4

2 JurgenRawis

o

2 Bruce Bennett

IW=T+Fvrv b

R oOEg e I——2BmL T, JI—7"+Fr v I
EERT DT EMNTEXT, JNV—TFr v b )b—
LSy I EBIMUT, ZOF vy b OB LEEHEIC
THTLETEET,

="+ F v Maid, LIRS K S, lilFv v
M EWViEMOA 7Y 3 VARHEINTVET,

o FI—"TF v NABREETLIZHOX T g

o FI—T Fr v DI IBRETDHHOLT
vaYv

o TN—7+F ¥y FTREDI—Y—LHFN X v
Y=V RN T BDOX T gV

o IR LTEREIN TV ENI—Y—2BRT BT
HdOETvay

IIV—7 « Fvv MERETBICIE -

1 BHFOF v v b« AL v RCE e —Y—28nd
0, FLF vy b ALy FEBBLET, 7b—
T Frw b ALY FIZBMLTVETNTDL—
Y= T—"" F v v MERgEL—— 28
TBHIEMNTEET,

2 Frv MEEOALMICEREN TS [z

F v MR (nvite Contacts to Chat) 77 3
VEIVYILUET,

Respectable Citizen

TheodoreGadamer,babbayac
’;‘ Double-click to set a topic E *

( v) (T v

2 rwardel

Hi Babba! How are things?| ©

FUWERIF v v b

3 TFAR-F¥ v b T )VRICAYy =V % AT
L. Return ¥— Mac D% %) %7213 Enter +—
(Windows D¥) Z# L %9,

4 FBCEREEDI S ERAyE—VIHATE LD
TEET GELIE, 30—V Tz e aditio
ISV EBRUTLEE WD),

28  Pro Tools D#HkAE

Add contact to chat:
Q ‘

O cst

() rwardell

JurgenRawls

() Bruce Bennett J
7,

hey theo, babba would
piano and you play cell
he's starting.

[ Jurgen, I think we could use your talent on a
new project that is planning. Can you
let me check my schedule, [ Refba is pl e b

¥ join he discussion?
. when you are ready to star|

‘You can only invite 28 more users to join the chat.

[carcer || Aas |

ZEURAW ’,l

3 BINY ZEEE L —AD Ay =T ATILT
GEM] (Add) RZx>ZI7 Vv I LET,

ﬂ hey, that would be great! i ¥
your cello parts recorded in about 3 weeks. i'll
send you the parts next week for you review.

EREL-—Y—ZII—T - Fry MIIBEF

BRI — IR EEN, FI—T - Fr v b
2z ORI —F—anEnxd,



IIh=T e Fyy b+ ALY RRDEE

TNW—"T«Fxvy NeBlthd s &, Fr v ML T
WA= —DEHINZTDTIN—T" Fv v FOLRTL
LCAENE T, FEDHHiZ T IV—7 F ¥ v b
FFze, F¥vy b UAMNTHDOTIV—T « Fv v
FeRATEZCENTEET, Fv v MRELETES
D&, TI—T+F vy bOBFEREFTI,

=7 « Fvv FREEETBICIE :
1 Fro b - XAV EBOTN—T « Fvy hOZRA R
WERZTIVIIy 7 LET,

Respectable Citizen

‘ B

v v v

piano and you play cello on a new project
he's starting.

JIV—7T - Fvv NROEE
2 JN—"7Fvv bOAHIZAII LT, Return F—

(Mac DHE) F7zld Enter ¥— (Windows D E)
EMLET,

=7 « Fyvy PO PEYIDERE

TN—"T"+Fx v MBIML T2 TXRTOI—H =1,
Fx¥ v b ALY ROMEY I ERETEHTENTEET,
MY I ERETRHTEICKD, TIV—THNTOHERD
BEERTHENTEET, PEY I ERETEZDIR,
TI—T Fvv hOLEEREITY,

I—T - Fry MO PEYIZRETBICIE :

1 JV—T+Fvv b - ZLRVDFCHBFEY T -
TA4—=IVREZTLVIV Y 7 LET,

Respectable Citizen
0 q A
,!l Babba's Spring Project B ‘1
—~ [panning stage |
v v v
piano and you play cello on a new project -
he's starting. ‘

JI—T - Fvv bOREY I DK

2 J)V—="7+Fvyw Oy Z%AILT, Return
F— (Mac DHE) F/zid Enter ¥— (Windows D
BE) ZMLET,

BAT  P—TAAN - Fry b -U1VRD

SNEAX=1—

SHERARAZ 2 —ZFHAL T, JI—T+F v FHD
FEDI—F—ICH U THEINCA Yy =V ZEET ST
EWNTEET, £z, dlifgee LTEREIN TRV II—
P—EERTELLTEET,

II—TADREDIL—F—[CH UL TEBIICX vy E—IZ#iEE
IBICR:

1 HRNC Ay b= P2 KRG LT a— —DBn#EH
AZa—=rUv 7 LEd,

2 [Avt—31 (Message) Z#ERL £,

TheodoreGadamer ¥

IIV—T - Fv v FNADKFEDI—Y—(I U THERIIC K v E—
JERE

3 MROI—YP—ITH L THEPNC A v =T ZEREL
E

AN Ry =V BRE LT VI—T—DF VT4 VIR
BEICE > TWERWES, ZOa—Y—Ic Ay b=V %%
E952LIETETETA,

II—JDBNMEEEHETE LTEMTBICTIE :

1 i LGBMLIEnI——DOBMNMER A =2 —
270w I LET,

2 [EfESEICENM] (Add to Contacts) ZE#ERL X9,

TheodoreGadamer ¥

LB Add to Contacts
Message
II—7 - F o v FOBMEEEELE U TEN
BHR U7z a—y—hpligea—y— L L oBimEnEd,
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FrybeXvE—YFrEZoOOVITY
b XvtE—IDIRE
BOMERLIEF vy b s Avke—I%Tadz s -
AvE—VICR o THRET DT AN TEET,

Fryb s XvE—IFERTOIII b - AvE—IERE
THICH:

1 WELIEVA Y=V BRBELET,

2 MEDAY =TIV I L, Ry TTwT - R
Za—7T [Xvt—U%#EE] (Edit Message) %

RUET,
[) .49 PM
Ifﬂit Message

B 11:49 PM

what are you thinking for the piano
parts?

do you still have that steinway in the
studio?

WETDXvE—IZERIVUYD

3 Ut YRYTNHOTFALFvw T r—)LFA
DASTEHBA =D fmELET,

4 FEMNTET L5, Return F— (Mac D6 £72&
Enter ¥— (Windows DIFE) ZLTA v —
FEELET,

when do you think you will have the
piano part ready? based on the last
project i'll need some time to work the
part up.

B 11:49 PM

do you still have that steinway in the
studio?

B 11:49 PM

HET7 A IVHRRENRERHIA v E—Y

Fyw MCBIL TV B TRTOI—PF—IcH U T, e
BHRA Y=V DOHERNCERET A aAVHEREIND 2D,
WEFEARA v b— VBB ET 3T N TEET,

30 Pro Tools D#kaE

FyybeXytE—=v&709ITIb
AyE=IDIT L WIVVT

FEDF— - V—FRZMFHLTFr v b« Avb—I®
TV Ik Ave—I%T VR TT BT LI
K0, BIEDF ¥ v FRWBEDF ¥ v N TITo 5D
NEEZTIERMET BT ENTEET,

Frybe XAytE—IPITOIIIb  RvtE—I%&IT1ILY

UYI9BICE:

1 7—T4 A F¥vb-UrVFUDkEMICHS
MEZT 4 —=IVRIC, Avbe—=V% T4 VEVVITT B
fedDF—T—FRZANLET, €T /] ®
ltelfunken u-47) %% F— - J—RELTANT
5Lt thosmdosiizF— - J—FELTA
NTBTEETEET,

2 ReturnF— (Mac D E) £7213 Enter +— (Windows
DR ZLT, T4V R ) VT ORRERRL
%9,

babba * Q) Respectab

Eonic ’ll TheodoreGadamer,babbayadda,JurgenRawls
Notifications AL panning stage

babbayadda v Jurgonavis ¥ | TheodoreGadamer ¥

»> Projects x
Today

¥ Chat *
312 TheodoreGadamer,bab..
2 babbayadda
318 JurgenRawis, Theodore.
2 TheodoreGadamer

Xy T—IZTAIIIIITTBRIHDF— - T—RZEAN

babbayadda has joined the chat.

hey theo, babba would like to have me play piano and you play cello B
on a new project he's starting.

BXF LRIV

TFAL «Frw b« T =)V FOAITIIIELFET A
VBBV EST, COTAAVEII Y ITEE, B
FEFREDRA UHERENET, CORAL VT . F vy
MIBINT 28RS EINT 2N TEET,

SENFOEREF vy MSEINTBICIE -
1 7FAbFr v b T 0=V FOAEICH BT
TAaAYEIV I LET,

2 MNFELHRORAL VD FBICHIBLET AV
OV 793, HHAGERT X TORFEH IR
INET, AMIC, SRERFT7AMavEIUy 7T
%L, FHATEER TR TOTENE RSN, a—FK -
TAAYEI VY ITBE HHANRERTRTDOI—
FiiBHERENET,



Respectable Citizen

1 TheodoreGadam

Ma

TheodoreGadamer has invit§
Citizen to join the chat.

4
<
€
3) @

(

©J =
&

You have accepted the conté

56 . M
= JORORY
D 6D 6 M E3

musician, but just between you and me, he can be a challenge to
work with. However, he pays well, so do consider it.

BXENRAY

3

F vy MTBINUZWEESCT, ik,
BEERLUET,

Frida—Fad

© D
b X
|

=
b & |||
ﬂ § B 1
e
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BiIB
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RN Eq
®J &

PERES
T
BB EE e

ES%

J— RESAAY

%

A48 T=FT4Ab - Fryh-D4VEKD

JOJzIOb - YRAMEEBF Yy bV
ART7LTLOEYBHPEY DERE

g— —

120

gL — DB RO I —L DT KL —
vavikE, vy T EIEREERTIE. T
OV 7 bk VAREFYy b - UARBEL KRBT E
MH Y ET, Pro Tools Tlk, TNEDY X kDIEFHIC T
AT LEEVREDTEHENTEET, EVEDT B4
Wl holzb, EVHDZERRETSZEETEET,

FOJz I PERRBFry b« ALY RZEVEHTBICIE -

1 VAMOREHICEVHDLIwWTaY o7 FEii
Frw bEHEIUY I LET,

2 [EV] (Pin) ZERLET,

¥ Chat +
¥ bavbayadda
218 Respectable Citiz...
39% TheodoreGa...

m Respectable...
2 TheodoreGa. .
1 Bruce Bennett

e

Frvhb- ALy REEVED

3 BRLEZTOY 2 FEREF vy FHY X PO
FICBEI LI,

JOY I bEEBF vy b ALY ROEVBHZERIRTSD
ISI3 :

1 CUEOZRHRLIEWTOY 27 FEREEF vy b
2EIUw I LET,
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BAEMOITRTOI—F =DV TE [TV H T 2—-
—5—DfEHE] (Conductor Ruler Ownership) 21>
bo—)LhA Ly P TERINET,

[ INE SRE S

cowas M
RID1— 5 —HAEL TN TV o5 — - —S—

{REPORAENE

MOI—F=WFELTVEIAV R T Z— - )b—F—D
FTEHEZ IS 21, 2O —F—Icx LT M
fE7z) ZWERITS W, [TV E T 2—)b—F— DA HE]
(Conductor Ruler Ownership) 3> ha—)L%z27 Yy
JLET, ZONV—F—DFHEFHIN LT, FraEReT
DY T AINFTEN EMEMEN, YT
PMARIRRBIC R D £, AV Ry 2— « V—F—DfiH
HEDEMZRES 5 L. HODTON—F—ZFHEAT
BT LICEDET,

v+
COLLAB -
REREOFEEDU TR h

dASKL— 3 Y DOYIHIERRE

Pro Toolsicld. Yayz 7 v CasRL—v 3 V&7
5 IO D—HOYNHRENHE TN TOET,
ASKRL—Y a3 VOIEEREICT I EATBICS -

1 [B%E] (Setup) > [#HAERE] (Preferences) %%
RUET,

2 [a5Kb— 3] (Collaboration) 27227V v 7
LET,

3 REAEREISRL—Y g YOYIWREICATIL
T OKl ZZ7VUvy o7 L%ET,
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Pro Tools | HD Preferences

New racks aro shared
st nte shares ai racks
Joiing project downloads al shared acks
Enable “Track Nols" disog

T -

FR Sy I%EHE (New Tracks Are Shared) C
DX T avEEMITSE. HUIMER LI T D
MNEIIMICHEENE T,

BRUIDBIEFTCE Sy o%HE (First Invite Shares
All Tracks) CcOF 7> a vzEEMICT S L hoa1—
P—ZHLOTOY 7 MR LIz EIZ, $XRTO
by I WNEHEICHEEINE T,

JOVzI FBNBICTRTORBISVIEI DY
O— K (Joining Project Downloads All Shared)
COXTvavERENCTRE, BB TR 2T M
ShLizeEic, 7ays 7 hHOTXRTORG Ty
IREABICAY v a— RENET,

FSy o /—rF4705%BHICTS (Enable
“Track Notes” Dialog) C D4 7> 3 Y 2GR T
b, Tuvel bEALIETIR. B LEVWI/ORE
REELENT ST AV EEDERELR—+35 b
Fwy e /=R ZALTRTNERENET, 04T
TAVENCT B L, LR— T S0END BHES
LT 358 ThoTh, FIv T - /—h - X470
JERRENEL A



58 6 = : TODfthDHEREILER

QuickTimeNOND I ABICHAL L
d—Re+ FSYIEBIMNZAD

[V—REAU] AT ¥ a VB RLT [§/L0—R b
Sy orBZRZ %] (Replace Timecode Track) # 7
avEAEMCTRE, Ly a YNTEIRLIZZA L
O— FRIEIC K D 28T Y A ENTz QuickTime 7 7 1)V
NDORXALI—F « FIv IHEEMASNET, V—
A+ BTE e T7ANVAIKEALIA—F « b Tv IHE
FNTWERWIEE N Y XE N QuickTime 7 7 1)V
Kty v a YHADRA La— RERHMNENENE T,

[V—2Z &@LU (Same as Source) & 7' 3 > ZHEENIC
2L, [F4L0—RbSyI%=BEHRZ 2] (Replace
Timecode Track) A 7> a UHAERENTVEHE S
MChhbHT, ok HLWT 7 AIVHBERET N,
twaYNTERLEZALO— RHEIENEH SN
9,

$F6E | TOMDEEEILR

QuickTime Bounce

Bounce Source: | Built-in Output 1-2 (Stereo) - E
File Type: | WAV v
Format: |Interleaved ~ ~
Bit Depth: |24 Bit T
Sample Rate: | 48 kHz v

Enforce Media Composer Compatibility
Import After Bounce
Add To iTunes Library

Include Video
Same as Source
Use Avid Codecs

Replace Timecode Track

File Name: | PeterBill_inda3|

Directory:

Nolumes/LaCie2TB/PeterBill_inda3/Bounced Files/

Offine [ —Cancs— = Boiince—
[F4LT—RISvIZEEHRA D] (Replace Timecode
Track) 7Y 3 vHEMICE>TLS [QuickTime [Z/{\D ]
(Bounce to QuickTime) ¥/70%J

49



Avid Interplay bHifE#EE N/ Pro
ToolsTOXDCAM AirSpeed7—
70-0YKR—-k

XDCAM AirSpeed D7 —2 7 u—%HKR— 9 5728,
Transfer Engine DFED [FHAEY—/S—IC3%(E] (Send
To Playback) # 7'¥ a3 ViZBENE L7z, Transfer
EnginelC & 0. REE NI —F V ADIRRS 72 #IRG
BTENTEES, 707 7 A )VHOBYEHET A A
ZERLUET, TDOY R M, Interplay Transfer
Engine. ¥ & GBI A3 54172 AirSpeed & AirSpeed
Multi Stream ¥ —/N—T{ERE NI T/8A DT T 7
AINWHEENE T, Interplay Administrator @ Interplay
Transfer i € 2 —T [T — S— A EREEMEFIRHC
ARMDAZIARAF2ERT %] (Show individual
studio hosts in Send to Playback choices) % 73 = > 7%
RUTE. DY R M AirSpeed Studio DIERDT
INAALEENDTEHBHDET,

AirSpeed Multi Stream ¥ —/3—ZE R L e, ¥—
N=FZDNWEHETNA AL, KRIC [-HDJ 28T
P=N—=HDMNNWTeHETNAADLEINTEET,
HD 7734 A& XDCAM-HD Long GOP A7« 7 D&
CHHTEET,

Export Options

Destination Sequance :
STP 1080i53 XDCAMS0 LongGOP_forPT_1

AddReplace Tracks
Choose either to "Replace with Selected Tracks” to erase all
of the current audio in the Pro Tools sequence and replace it
with the audio from the selected tracks, or "Add Selected
Tracks" to add the audio from the selected tracks as new
tracks within the Pro Tools sequence.

© Replace with Selected Tracks
Add Selected Tracks

Export stereo, 5.1 and 7.1 tracks as multi-channel

Send To Playback
Send

Web Service Address

airspeed5k/AirSpeadsk
EELELEE  airspesdSk/AirSpeedsSk-HD
airspeedSk/AirSpeedSk-HD

Select Media T airspeedSk/AirSpeedsk-HD
© same as Sourcs

Select Workspace  scarson [ENG-ISIST000] had

[ Cancol "ok

[TORR— ATV 3] Y4705 T. XDCAM-HD Long
GOP X5« ZH®DHD 7/ R7Z:&E1R
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XDCAM AirSpeed D9—o70—%{#&
RAT5E8ICHEBIEYI MO LT

XDCAM ©7—2 710 —7T [[HEY—/N—IZ%E]
(Send to Playback) #fEZEHT 5Icid. UTDY T
YT REICED £,

* Interplay Transfer
* Interplay Web Services

* Avid Production Services Engine(XDCAM 7—7%
Tu—ZHY B 5HAEDR)

» Avid STP Encode (XDCAM YV —72 7 u—7%{{fd
BEHDH)



S$E7% : Pro Tools 12.5.1 Dint%aE

Yy vak—-Fe@ALETOYIIb .
ASKL—2 3 DiRGHEE

ZyyaR—=REMFALT, 7OYzy bAOHRGER
RLUIOIERLIEDTESLIICEDE L, Bloa—
P—ho oy 7 McffEhz e, K7 1av e
EKRBT7Aavekdic, oAy "R Ry v a
R—RO7ayxr b« UARMIEREINET,

Dashboard
¥ TheodoreGadamer (Storage: 1%) v
CREATE ~
| quintet
¥ Invited by Respectable Citizen 200
RECEMT; (7\) Proj_RC 00
¥ Invited by Respectable Citizen
PEOECD (/%) Quartet_Andante o
Y 3/24716,11:58 PM
() WhirrledBeat
0 3/24/16, 9:49 PM b4
(7\) Le Charm
A 3/21/16,9:33 PM b4
Show on startup {*Gpon from Disk i Cancol | Opon |

7OV 0 MOBMERDRRENCY vV aRk—R

FvyaiRk—RTITOIV I PADSINERDIESORBET

SIClE :

1 Xy¥aR—FT [Pz ] (Projects) #77%
BINLE T, AfFchiz7ay o7 MaoAflc, &
BHDT7 AV EEEHOT A 2V hERRENE T,

2 TFOVWINhEITNET,

o« KRT AR LTTaY Ly McBnY %,

e HET AV EI Yy I LTATKRL—Y 3 v OIEAE
FHEGL, BEFEINETav o7 v E Ty s b .
U A M BHIRY %,

2 7% ! Pro Tools 12.5.1 D¥itk#E

P=FA4AM FYvYBbe D4V RITT
OYx o bR BEE

T—=T4 A F¥v Uy FUvOTuI s Y
ART, FEOTuY 27 bR T EMTEEXT,

P=F4ARMFrybosYROTIOY I MERHKICR:

s TRV URAMTTRY LY T AaAVES
TIWIIw I LET,
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Avid
280 N Bernardo Avenue
Mountain View, CA 94043 USA

TOZAI - BiRk—b
FISAY - YR—bk - Y-
(www.avid.com/jp/support)
[E7OEALTLEEL,

KB

R EHBDBERICOVTIF
Lo hZESRULTEEN
www.avid.com
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